
HP ProLiant Essentials  
Rapid Deployment Pack—Windows Edition 

Installation Guide 

 
January 2004 (Second Edition) 

Part Number 352869-002 
Product Version 1.50 

 

 
HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 9:36 AM 

 



© Copyright 2003, 2004 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with 
FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical 
Data for Commercial Items are licensed to the U.S. Government under vendor’s standard commercial license. 

The information contained herein is subject to change without notice. The only warranties for HP products and 
services are set forth in the express warranty statements accompanying such products and services. Nothing herein 
should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors 
or omissions contained herein. 

Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United 
States and other countries. Linux is a U.S. registered trademark of Linus Torvalds. Microsoft, DOS, and Windows 
are U.S. registered trademarks of Microsoft Corporation.  

HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 

January 2004 (Second Edition) 
Part Number 352869-002 
Product Version 1.50 

 

 

 
HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 9:36 AM 

 



 
Contents 

About This Guide 
Audience Assumptions..................................................................................................................................v 
Related Documents........................................................................................................................................v 
Where to Go for Additional Help.................................................................................................................vi 

Online Resources ...................................................................................................................................vi 
Telephone Numbers ...............................................................................................................................vi 

Chapter 1 
Licensing 
Overview ................................................................................................................................................... 1-1 
Licensing Options...................................................................................................................................... 1-1 
Obtaining Licenses .................................................................................................................................... 1-2 

Evaluation Licenses ............................................................................................................................ 1-2 
Purchased Licenses ............................................................................................................................. 1-2 

Applying a License File ............................................................................................................................ 1-3 
Applying License Files During a First-Time Installation ................................................................... 1-3 
Applying License Files During an Upgrade Installation .................................................................... 1-3 
Adding Licenses to an Existing Installation ....................................................................................... 1-3 
Replacing Licenses in an Existing Installation ................................................................................... 1-4 

Chapter 2 
First-Time Installation 
Deployment Infrastructure......................................................................................................................... 2-1 

Basic Deployment Infrastructure ........................................................................................................ 2-1 
Multi-Server Deployment Infrastructure ............................................................................................ 2-2 

Installation Requirements.......................................................................................................................... 2-3 
Network Infrastructure Requirements................................................................................................. 2-3 
System Requirements.......................................................................................................................... 2-3 

Basic Installation ....................................................................................................................................... 2-6 
Altiris Deployment Solution ............................................................................................................... 2-8 
ProLiant Integration Module for Deployment Server....................................................................... 2-16 
ProLiant Integration Module for NFS Server ................................................................................... 2-21 

Multi-Server Installation ......................................................................................................................... 2-26 
Altiris Deployment Solution ............................................................................................................. 2-26 
ProLiant Integration Module for Deployment Server....................................................................... 2-39 
ProLiant Integration Module for NFS Server ................................................................................... 2-39 

HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide iii 

  
 

HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 9:36 AM 

 



Contents 

Chapter 3 
Upgrading 

Altiris Deployment Solution................................................................................................................3-1 
ProLiant Integration Module for Deployment Server .......................................................................3-11 
ProLiant Integration Module for NFS Server....................................................................................3-15 

Chapter 4 
Pre-Deployment Configuration for the Deployment Server 
Configuring PXE to Automatically Process New Computers ...................................................................4-1 
Synchronizing the Deployment Server Console Name with the Windows Name.....................................4-3 
Modifying the Primary Lookup Key..........................................................................................................4-4 
Configuring ProLiant BL Server Enclosures .............................................................................................4-6 

ProLiant BL e-Class Servers ...............................................................................................................4-6 
ProLiant BL p-Class Servers ...............................................................................................................4-7 

Creating Physical Boot Diskettes for Server Deployment.........................................................................4-9 

Chapter 5 
Pre-Deployment Configuration for Windows Scripted Install Jobs 
Preconfiguring the ProLiant Support Pack for Windows ..........................................................................5-1 
Preconfiguring the Altiris Deployment Agent for Windows .....................................................................5-3 
Modifying the Microsoft Windows unattend.txt File ................................................................................5-4 

Chapter 6 
Pre-Deployment Configuration for Linux Scripted Install Jobs 
Preconfiguring the ProLiant Support Pack for Linux ................................................................................6-1 
Preconfiguring the Deployment Settings for Red Hat Linux Scripted Install Jobs ...................................6-2 
Preconfiguring the Deployment Settings for UnitedLinux Scripted Install Jobs.......................................6-3 

Chapter 7 
Pre-Deployment Configuration for Packaged Cluster Deployment Jobs 
Step 1:  Creating and Customizing a Configuration File ...........................................................................7-1 
Step 2:  Providing the Domain Administrator Account for Packaged Cluster Deployment......................7-2 
Step 3:  Making the Cluster Nodes Available in the Deployment Server Console....................................7-3 

Importing the Cluster Node .................................................................................................................7-3 
Creating the Computer Group .............................................................................................................7-4 

Step 4:  Customizing the Microsoft Answer Files for Packaged Cluster Scripted Install Jobs .................7-5 
Step 5:  Creating a Reference Configuration for a Packaged Cluster Imaged Install ................................7-6 

Appendix A 
Manually Installing Windows Operating System CDs 

Appendix B 
Manually Installing Red Hat Enterprise Linux Boot Files 

Appendix C 
Manually Installing Linux Distribution CDs 

Index 

iv HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 

  
 

HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 9:36 AM 

 



 
About This Guide 

This guide provides detailed information about installing the Rapid Deployment  
Pack—Windows Edition, configuring the Deployment Server and the provided scripted 
installation jobs and files, and upgrading to newer versions of software. 

Audience Assumptions 

To install and configure the Rapid Deployment Pack, it is assumed that you have  
knowledge of: 

• Installing Microsoft® Windows®, either from CD or the network, using the unattend.txt 
mechanism 

• Basic Windows management and administration, such as manipulating files and folders 
in Windows Explorer, creating users and groups in Computer Management, and setting 
share permissions 

• (For Linux® deployments only) Installing Linux either from CD or a network 

• (For Linux deployments only) Basic Linux command line interface operations; for 
example, mounting and unmounting floppy and CD-ROM drives, creating directories, 
and copying files 

• Network infrastructure 

To perform tasks after the installation is complete, it is assumed that you have knowledge of 
editing files within Windows and Linux. 

Related Documents 

HP recommends reviewing the following documentation before reading this guide: 

• HP ProLiant Essentials Rapid Deployment Pack Planning Guide 

• HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Support Matrix 
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About This Guide 

HP recommends reviewing the following documentation after reading this guide: 

• HP ProLiant Essentials Rapid Deployment Pack—Windows Edition User Guide 

All of the documents can be found in .pdf format at http://www.hp.com/servers/rdp, from the 
Rapid Deployment Pack CD autorun utility, at \pim-ds\docs on the product CD, and at .\docs 
on the Deployment Server. 

Where to Go for Additional Help 

Refer to the following sources for additional information about the Rapid Deployment Pack. 

Online Resources 

• HP ProLiant Essentials Rapid Deployment Pack website at 
http://www.hp.com/servers/rdp 

• HP ProLiant Essentials Rapid Deployment Pack Knowledge Base at 
http://www.hp.com/servers/rdp 

• HP ProLiant Essentials Rapid Deployment Pack What’s New at 
http://www.hp.com/servers/rdp 

• ITRC User Forum “ProLiant Deployment & Provisioning” at http://forums.itrc.hp.com 

• Altiris website at http://www.altiris.com 

Telephone Numbers 

For the name of your nearest HP authorized reseller: 

• In the United States, call 1-800-345-1518. 

• In Canada, call 1-800-263-5868. 

For HP technical support: 

• In the United States and Canada, call 1-800-652-6672. 

• Outside the United States and Canada, refer to http://www.hp.com. 
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1 
Licensing 

Overview 

A license allows a server to be deployed and managed by the Altiris Deployment Solution. 
One license is required for each server being managed. After a license is applied to a specific 
server, the license cannot be removed or transferred to another server. 

A license file contains licenses for a predetermined number of servers. License files are 
applied without reference to the Rapid Deployment Pack version and are not specific to 
Rapid Deployment Pack—Windows Edition or Rapid Deployment Pack—Linux Edition, as 
long as the one license per server requirement is met. 

Licensing Options 

The Rapid Deployment Pack offers five license purchasing options: 

• 

• 

• 

• 

• 

One-node license—Use this license to deploy and manage one server through the 
Deployment Server. 

10-node license—Use this license to deploy and manage 10 servers through the 
Deployment Server. 

Flexible Quantity license—These kits are available to obtain an exact quantity of licenses 
in the purchase of a single software option kit. 

Activation Key Agreement—This option provides the ability to order a key in the 
quantity desired and for a specific time and purchase a license for each server deployed 
over time. 

Blade enclosure bundle—A bundle of eight or 20 licenses are available with a ProLiant 
BL server enclosure. 

For more information about Flexible Quantity license and Activation Key Agreement 
options, refer to the ProLiant Essentials Licensing Options at http://www.hp.com/servers/rdp. 
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Licensing 

Obtaining Licenses 

The following sections explain how to obtain evaluation or purchased licenses for your 
servers. 

Evaluation Licenses 

Two types of evaluation licenses are available for use: 

• 

• 

A 10-node, seven-day evaluation license is built into the Deployment Solution. No 
license file is required. The evaluation license can be applied during the Deployment 
Solution installation. 

To obtain and use a 10-node, 30-day evaluation license: 

a. Access http://www.hp.com/servers/rdp/eval. 

b. Follow the online instructions to complete the registration process. An evaluation 
license file will be e-mailed to you. 

Purchased Licenses 

To register your product and obtain your license file: 

1. Locate the unique 20-character product registration number on the label on the back of 
the software packaging box. The registration number is in the form: 

xxxxx-xxxxx-xxxxx-xxxxx 
 

IMPORTANT:  Keep your product registration number for future reference. 

2. Access http://www.hp.com/servers/rdp/register.  

3. Follow the online instructions to complete the registration process. A license file will be 
e-mailed to you. 

Additional purchased licenses can be transferred or combined with already registered 
licenses. Refer to the instructions at http://www.hp.com/servers/rdp/register. 
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Licensing 

Applying a License File 

The following sections explain how to apply evaluation or purchased licenses to your servers 
and how to add or replace existing licenses. 

Applying License Files During a First-Time Installation 

A 10-node, seven-day evaluation license is built into the Deployment Server. To apply this 
license, select Free 7 day license or maintenance upgrade during the first-time installation 
at the Deployment Server Client Access Point Information screen. 

To apply a purchased or evaluation license file, enter the path to the license file in the License 
File field during the installation at the Deployment Server Client Access Point Information 
screen. 

To view the number of licensed nodes from the console, click Help>About. 

Applying License Files During an Upgrade Installation 

To continue using existing licenses after performing an upgrade, select Free 7 day license or 
maintenance upgrade during the installation at the Deployment Server Client Access Point 
Information screen. 

To view the number of licensed nodes from the console, click Help>About. 

Adding Licenses to an Existing Installation 

To apply additional purchased licenses to an existing installation, add the new license file to 
your Deployment Server: 

1. Run the Altiris License utility by clicking Start>Programs>Altiris>Altiris 
eXpress>Deployment Server>Product Licensing Utility. 

2. Enter the path to the new license file path in the Activation Key File Information field, 
and then click Next. 

3. Follow the online instructions to apply your additional licenses. 

To view the number of additional licensed nodes from the console, click Help>About. 
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Replacing Licenses in an Existing Installation 

If you have previously purchased, returned, or transferred licenses and have obtained a new 
license file to replace your existing license file: 

1. Run the Altiris License utility by clicking Start>Programs>Altiris>Altiris 
eXpress>Deployment Server>Product Licensing Utility. 

2. Enter the path to the new license file path in the Activation Key File Information field, 
and then click Next. 

3. Follow the online instructions to apply your additional licenses, ensuring that the 
Replace all existing license Activation Keys with this new Activation Key checkbox is 
selected. 

To view the number of licensed nodes from the console, click Help>About. 



2 
First-Time Installation 

Deployment Infrastructure 

The following sections describe basic and multi-server deployment infrastructures, and the 
components of each. 

Basic Deployment Infrastructure 

In a basic deployment infrastructure, all the server components (the Altiris Deployment 
Solution components and the ProLiant Integration Module for Deployment Server) are 
installed on one Windows-based server. This infrastructure is recommended for first-time 
installations.  

The Altiris Deployment Solution components include: 

• 

• 

• 

• 

• 

• 

Deployment Server Console 

Deployment Server 

Preboot eXecution Environment (PXE) server 

Client Access Point (file share) 
 

IMPORTANT:  Database management software is no longer automatically installed with the Rapid 
Deployment Pack, but is required. MSDE 2000 with Service Pack 3a is provided on the Rapid 
Deployment Pack CD and can be installed with the new Local Computer Install Helper or manually from 
[CD-ROM drive:]\extras\msde. 

The ProLiant Integration Module for NFS is installed on a Linux-based server. The Rapid 
Deployment Pack uses NFS as the Linux installation method because: 

The NFS installation method works best across the various Linux distributions. 

Advanced Linux users can use a Linux server running NFS to build kernels, drivers, or 
other components that can be installed along with the distribution.  
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First-Time Installation 

The following graphic illustrates a basic deployment setup. 

 

Multi-Server Deployment Infrastructure 

A multi-server deployment infrastructure installation enables you to select which server 
components to install on multiple Windows-based servers. For example, you can assign 
another file server as the Client Access Point or another server as the database. 

As with the basic installation method, the ProLiant Integration Module for Deployment 
Server is installed on the intended deployment server, and the ProLiant Integration Module 
for NFS Server used for Linux scripted installations is installed on the NFS server. 
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First-Time Installation 

The following graphic depicts the multi-server deployment infrastructure. 

 

Installation Requirements 

This section describes the requirements to successfully install each component of the Rapid 
Deployment Pack. 

 
NOTE:  The Rapid Deployment Pack cannot be installed through a Terminal Services or remote shell 
connection. 

Network Infrastructure Requirements 

The Rapid Deployment Pack is designed to perform optimally with DHCP and PXE in the 
network environment. If PXE is used to perform remote deployment of servers, DHCP must 
be installed and accessible on the network before the Altiris Deployment Solution installation 
to ensure correct installation of PXE services.  

System Requirements 

The following system requirements for the deployment server, NFS server, and target servers 
must be met before installing the Rapid Deployment Pack.  
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First-Time Installation 

Deployment Server 

The deployment server hardware and network configuration must meet the following 
requirements: 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Intel® Pentium® III or higher processor 

At least 256 MB RAM 

CD-ROM drive 

Network connection, configured with a static IP address 
 

IMPORTANT:  It is difficult to change the IP settings to point to a different NIC after the 
Deployment Solution is installed on a system. Changing these settings could cause the 
Deployment Server to function incorrectly. 

Current date and time for the Deployment Server set using ROM-Based Setup Utility 
(RBSU). 

The deployment server software and configuration must meet the following requirements: 

A supported Windows operating system installed (for supported operating systems, refer 
to the HP ProLiant Essentials Rapid Deployment Pack—Windows Edition 
Support Matrix) 

1.5 GB of disk space available, plus additional space to store any captured disk images, 
additional Windows operating systems, or application installation files 

ProLiant Support Pack for Windows installed to provide the latest supported network 
drivers for the Deployment Server 

HP recommends having the following items available: 

A license file for purchased licenses or 30-day evaluation licenses (for information about 
licensing, refer to Chapter 1 of this guide) 

Windows 98 Second Edition boot diskette or CD (required for creating PXE images and 
boot diskettes) 

Windows 2000 and/or Windows Server 2003 operating system CDs 

Red Hat Enterprise Linux distribution CD #1 (required for populating boot files if certain 
Red Hat Enterprise Linux jobs are selected) 

For additional information about requirements for the Deployment Server, refer to the Altiris 
Deployment Solution 6.0 Product Guide, which can be found at 
http://www.hp.com/servers/rdp. 

2-4 HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 

  
 

HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 9:42 AM 

 

http://www.hp.com/servers/rdp


First-Time Installation 

NFS Server 

The NFS server hardware and network configuration must meet the following requirements: 

• 

• 

• 

• 

• 

• 

CD-ROM drive 

A network connection configured with a static IP address and DNS available on the 
network (if a host name is used in the provided jobs) 

The NFS server software and configuration must meet the following requirements: 

A supported Linux operating system installed (for supported operating systems, refer to 
the HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Support Matrix) 

ProLiant Support Pack for Linux installed to provide the latest supported network drivers 
for the NFS server 

At least 1.9 GB of disk space available on the /usr directory for each distribution installed 
from the Linux NFS server 

NFS software installed and configured (if a firewall is installed on the server, the 
configuration must allow incoming NFS connections; for example, UDP port 2049 for a 
typical NFS port) 

For the Rapid Deployment Pack installation, HP recommends having Red Hat Linux or 
UnitedLinux distribution CDs available. 

Target Servers 

The Rapid Deployment Pack supports ProLiant BL servers and select ProLiant ML/DL 
servers. For details on target server requirements, refer to the HP ProLiant Essentials Rapid 
Deployment Pack—Windows Edition Support Matrix for your version of Rapid 
Deployment Pack. 
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First-Time Installation 

Basic Installation 

To install software from the Rapid Deployment Pack—Windows Edition CD to the 
deployment server: 

1. Insert the Rapid Deployment Pack—Windows Edition CD into the intended 
deployment server. 

2. Read the license agreement displayed by the autorun. If you agree to the terms of the 
license agreement, click Agree to continue.  
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First-Time Installation 

3. Review the pre-installation steps before installing the Rapid Deployment Pack software. 
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First-Time Installation 

Altiris Deployment Solution 
1. Click (1) Altiris Deployment Solution from the left pane of the autorun menu, and then 

click Altiris Deployment Solution X.X, where X.X is the software version. 
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First-Time Installation 

2. If you do not have an existing local database management system, either: 

— Cancel the installation and install MSDE 2000 with Service Pack 3a. 

— Select Local Computer Install Helper, click Install, and follow the on-screen 
instructions to install MSDE with Service Pack 3a. 

After the installation is complete, reboot the server and restart the installation. 
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First-Time Installation 

3. Select Simple Install, select the Include PXE Server checkbox, and then click Install to 
begin the installation process 

 

4. If installing on a system with multiple network interface cards (NICs), select the NIC to 
use as the Deployment Server interface, then click Select IP. 

 
 

IMPORTANT:  It is difficult to change the IP settings to point to a different NIC after the Deployment 
Server software is installed on a system. Changing these settings could cause the Deployment Server 
to function incorrectly. 
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First-Time Installation 

5. Read the license agreement. If you agree to the terms of the license agreement, click Yes 
to continue. 
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First-Time Installation 

6. At the Deployment Server Client Access Point Information screen, enter the 
user-specified information as appropriate, and then click Next. 

— File server path—This is the default installation directory. Accept the default path of 
.\program files\altiris\express\deployment server. 

 
NOTE:  Specify a drive with enough available space to hold the disk images to be captured 
and deployed. 

— Create eXpress share—Be sure that this checkbox is selected (default). 

— License file—Select Free 7 day license or maintenance upgrade, or enter the 
license file path and name. For more information, refer to Chapter 1 of this guide. 

— Service username—Accept the default user name (be sure it has administrator 
privileges). 

— Service Password—Enter the appropriate password for the Service username.  
 

NOTE:  The Service password is used for running the services and accessing the file share. The DOS 
agent environment stores the password in an encrypted file. 
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First-Time Installation 

7. Click Install at the Installation Information screen. The Deployment Solution installation 
begins. 
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First-Time Installation 

8. During the installation, you are prompted for either a Windows 9x boot diskette, CD, or a 
location from which to extract several DOS® files to create PXE images and boot 
diskettes. Specify the appropriate location from which to extract files, and then click 
Next. Follow the prompts to install the DOS files. 

 
 

IMPORTANT:  If DOS files are provided from a diskette, the installation program might also prompt 
for optional DOS files. To omit copying the optional DOS files, select No longer prompt for 
optional files, and then click Finish.  

9. If the Windows 9x CD is used to install DOS files, reinsert the Rapid Deployment  
Pack—Windows Edition CD back into the CD-ROM drive when prompted to continue 
the Deployment Solution installation. 
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First-Time Installation 

10. Click Finish at the Installation Information Summary screen. 
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First-Time Installation 

ProLiant Integration Module for Deployment Server 
1. Click (2) HP ProLiant Integration Module for Deployment Server from the left pane 

of the autorun menu, and then click HP ProLiant Integration Module for Deployment 
Server X.XX, where X.XX is the software version. 
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First-Time Installation 

2. Read the license agreement. If you agree to the terms of the license agreement, select 
I agree to all the terms of the preceding License Agreement, and then click Next to 
continue. 
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First-Time Installation 

3. A list of available deployment jobs appears. Select the deployment jobs that you want to 
import into the Deployment Server Console based on your deployment needs, and then 
click Next. The provided deployment jobs consist of: 

— Scripted Install Jobs—Enable a scripted hardware configuration and operating system 
installation of Windows, Red Hat Linux, or UnitedLinux to be performed on an 
unconfigured ProLiant server 

— Imaging Jobs—Enable the capture of the hardware configuration of a server and an 
image of a server hard drive, including the operating system and software 
applications, and deploy this hardware configuration and image to unconfigured 
ProLiant servers 

— Hardware Configuration Jobs—Enable the capture of the hardware configuration of 
an existing server and deploy that configuration to other servers 

— Packaged Cluster Deployment Jobs for Windows—Enable deployment of 
ProLiant DL380 Packaged Clusters using either imaging or scripting 
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First-Time Installation 

4. At the Installation screen, click Next to start the installation. 
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First-Time Installation 

5. If necessary, you are prompted to insert operating system CDs to allow appropriate files 
required for scripted install jobs to be copied to the Deployment Server directory. Click 
Next to begin the copy process. 

  
IMPORTANT:  If you omit the Windows operating system CD and/or Red Hat Enterprise Linux boot 
file copying steps at this time by clicking Cancel, you can manually install these files at a later time. 
For instructions, refer to the appendices of this guide. 

 
NOTE:  You are prompted for a Red Hat Enterprise Linux CD #1 to copy only the Linux boot files to 
the Deployment Server. The Red Hat Enterprise Linux distribution CDs are still installed on the 
Linux NFS server. The version and Update of the CDs used during the installation of the NFS 
server and the Deployment Server must match.  
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First-Time Installation 

6. Read the post-installation information displayed at the Finish screen, and then 
click Finish. 

 

7. Reboot the deployment server to complete the ProLiant Integration Module for 
Deployment Server installation. 

The Deployment Server installation is complete. However, before attempting to use the 
Deployment Server to perform scripted installations, complete the appropriate 
pre-deployment procedures in this guide. 

ProLiant Integration Module for NFS Server 

A Linux NFS server is required to deploy Linux using the provided scripted install jobs. To 
install the Rapid Deployment Pack on the Linux NFS server: 

1. Log in as root at the intended NFS server. 

2. Mount the CD: 

mount /mnt/cdrom (Red Hat) 

or 

mount /media/cdrom (UnitedLinux) 
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First-Time Installation 

3. Run the setup script:  

/mnt/cdrom/pim-nfs/setup-pimnfs.sh (Red Hat) 

or 

/media/cdrom/pim-nfs/setup-pimnfs.sh (UnitedLinux) 
 

NOTE:  Do not change directory to the CD-ROM directory to run the setup script. 

 

4. Enter 1 to start the installation, and then press the Enter key. 
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First-Time Installation 

5. Read the license agreement displayed, and then enter q. 

 

6. If you agree to the terms of the license agreement, enter 1 to accept the license 
agreement, and then press the Enter key. 
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First-Time Installation 

A list of the supported Linux distributions that can be deployed with Rapid Deployment 
Pack appears. Selecting a Linux distribution copies the ProLiant Support Pack files for 
that distribution and starts the Linux distribution CD query process to copy the Linux 
files onto the NFS server. 

7. For each distribution to be installed, enter the corresponding selection number for the 
distribution and press the Enter key. To select all distributions, enter the appropriate 
number to SELECT all and press the Enter key. 

 
NOTE:  Selection numbers vary depending on the number of available distributions. 

 

8. When you have selected all the Linux distribution to be installed, enter the appropriate 
number to ACCEPT selections and press the Enter key. The file copy and CD query 
process begins. 

9. After the ProLiant Support Pack files and distributions files are copied and you are 
prompted for the Rapid Deployment Pack—Windows Edition CD, insert the CD into the 
CD-ROM drive. 
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First-Time Installation 

10. The following screen confirms the ProLiant Integration Module for NFS Server 
installation is complete. Enter 1 to finish the installation, and press the Enter key. 

 

The ProLiant Integration Module for NFS Server installation is complete. However, before 
attempting to use the Deployment Server to perform Linux distribution scripted installations, 
complete the appropriate pre-deployment procedures in this guide. 
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First-Time Installation 

Multi-Server Installation 

A multi-server deployment infrastructure installation enables you to select if and where you 
want to install each component of the Altiris Deployment Solution. As with the basic 
installation method, the ProLiant Integration Module for Deployment Server is installed on 
the intended Deployment Server, and the ProLiant Integration Module for NFS Server used 
for Linux scripted installations is installed on the NFS server. : 

Altiris Deployment Solution 

To install the Altiris Deployment Solution in a multi-server deployment infrastructure: 

1. Click (1) Altiris Deployment Solution from the left pane of the autorun menu, and then 
click Altiris Deployment Solution X.X, where X.X is the software version. 
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First-Time Installation 

2. Select Custom Install, and then click Install to begin the installation process. 
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First-Time Installation 

3. Read the license agreement. If you agree to the terms of the license agreement, click Yes 
to continue. 
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First-Time Installation 

4. At the Deployment Server Client Access Point Information screen, enter the 
user-specified information as appropriate, and then click Next. 

— File server path—This is the Altiris default installation directory. Accept the default 
path of .\program files\altiris\express\deployment server. 

 
NOTE:  Specify a drive with enough available space to hold the disk images to be captured 
and deployed. 

— Create eXpress share—Be sure that this checkbox is selected (default). 

— License file—Select the Free 7 day license or maintenance upgrade option, or 
enter the license file path and name. For more information, refer to Chapter 1 of 
this guide. 
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First-Time Installation 

5. At the Deployment Server Information screen, enter the user-specific information as 
appropriate, and then click Next. 

a. Select On this computer to install the Deployment Server on the local computer, or 
select On a remote computer and enter the computer name of the remote computer 
to install the Deployment Server on an existing server. 

b. Enter the IP address of the interface that the Deployment Server will use. 

c. Enter the directory path where the Deployment Server files are installed. This should 
be the same location as used in the previous screen (accept the default). 

d. Enter the Service Username and Service Password of the Administrator account. 
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First-Time Installation 

6. At the Deployment Server Database screen, enter the name of the server where the 
database is located, and then click Next. If the database is located on the Deployment 
Server, the server name appears by default. 

 
 

NOTE:  If the database is located on a remote server, you might be prompted for authentication. Enter 
a user name and password with administrative rights. 
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First-Time Installation 

7. If you selected to install to an existing SQL database, the Gathering Information screen 
appears, allowing the name and password for accessing the SQL server to be entered. If a 
unique name and password has been specified during SQL install, it can be entered here. 
Enter the appropriate SQL user name and password in the fields provided, and then click 
Next to continue. 
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First-Time Installation 

8. At the PXE Server Information screen, select your PXE options. Be sure that Make this 
server the Master PXE server and Create default PXE boot files are selected, and 
then click Next to continue.. 
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First-Time Installation 

9. At the Client Connection to Deployment Server screen, specify how the client will 
connect to the Deployment Server, and then click Next to continue. 

a. Select Use TCP/IP to be sure that the clients connect directly to the Deployment 
Server. 

b. Be sure that the IP address is correct for the Deployment Server. 
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First-Time Installation 

10. At the Deployment Server Console Information screen, determine the GUI console 
location, and then click Next to continue.  

a. If the console will be on the current Deployment Server, select On this computer. 

b. If the console will be on a remote computer, select On a remote computer, and enter 
the name of the remote computer. 
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First-Time Installation 

11. Click Install at the Installation Information screen. The Deployment Server software 
installation begins. 
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First-Time Installation 

12. During the installation, you are prompted for either a Windows 9x boot diskette, CD, or a 
location from which to extract several DOS files to create PXE images and boot 
diskettes. Specify the appropriate location from which to extract files, and then click 
Next. Follow the prompts to install the DOS files. 

 
 

IMPORTANT:  If DOS files are provided from a diskette, the installation program might also prompt 
for optional DOS files. To omit copying the optional DOS files, select No longer prompt for 
optional files, and then click Finish.  

13. If the Windows 9x CD was used to install DOS files when prompted, reinsert the Rapid 
Deployment Pack—Windows Edition CD in the CD-ROM drive when prompted to 
continue the Deployment Solution installation. 
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First-Time Installation 

14. Click Finish.  
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ProLiant Integration Module for Deployment Server 

To install the ProLiant Integration Module for Deployment Server on the Deployment Server, 
follow the steps in the “ProLiant Integration Module for Deployment Server” section under 
“Basic Installation.”  

 
IMPORTANT:  When a custom installation of the Altiris Deployment Solution is performed, the ProLiant 
Integration Module for Deployment Server must be installed on the same machine on which the 
Deployment Server Console component was installed. 

ProLiant Integration Module for NFS Server 

To install the ProLiant Integration Module for NFS server on a Linux server for Linux 
scripted installations, follow the steps in the “ProLiant Integration Module for NFS Server” 
section under “Basic Installation.” 



3 
Upgrading 

 
IMPORTANT:  Shut down the Deployment Server Console before attempting to upgrade the Rapid 
Deployment Pack software.  

To upgrade the Rapid Deployment Pack software currently installed on the Deployment 
Server, insert the Rapid Deployment Pack—Windows Edition CD into the Deployment 
Server. An autorun menu appears.  

Altiris Deployment Solution 
 

IMPORTANT:  If you obtained your existing licenses before 11/20/2003, you should have received a 
new license file validating your licenses for an Altiris 6.0 software upgrade and providing 10-year 
Annual Upgrade Protection. Apply this new license file with the Altiris License Utility before upgrading to 
the Rapid Deployment Pack 1.50. If you did not receive this license file, contact HP support before 
upgrading. Upgrading before applying a new license file can cause your existing licenses to become 
invalid, resulting in a reduced license count (possibly to zero).  

1. From the Software Upgrades page, click Altiris Deployment Solution X.XX, 
where X.XX is the software version.  
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Upgrading 

2. Select the same installation method used for the initial installation (either Simple Install 
or Custom Install).  

 

3. Click Install to begin the upgrade process. Refer to “Simple Install” or “Custom Install” 
to complete the Deployment Solution upgrade. 

Simple Install 

1. When prompted to select if you want to use the database from the previous version of the 
Altiris Deployment Solution, click Yes to keep all of the data intact. 

 
IMPORTANT:  If you do not keep the existing database, all deployment history, customized jobs, 
and servers listed in the Deployment Server Console are lost. 

 

2. Read the license agreement. If you agree to the terms of the license agreement, click Yes 
to continue. 
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Upgrading 

3. At the Deployment Server Client Access Point Information screen, select Free 7 day 
license or maintenance upgrade to use your current licenses, enter the appropriate 
Service username and Service password, and then click Next. 

 
IMPORTANT:  If you obtained your existing licenses before 11/20/2003, you should have received a 
new license file validating your licenses for an Altiris 6.0 software upgrade and providing 10-year 
Annual Upgrade Protection. Apply this new license file with the Altiris License Utility before upgrading to 
the Rapid Deployment Pack 1.50. If you did not receive this license file, contact HP support before 
upgrading. Upgrading before applying a new license file can cause your existing licenses to become 
invalid, resulting in a reduced license count (possibly to zero).  
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Upgrading 

4. Click Install at the Installation Information screen to begin the software installation. 

5. When prompted to replace the eXpress share, click Yes. 

 

6. When prompted to recreate the boot images, click Yes. 

 

7. Click Finish at the Installation Information Summary screen. 

Custom Install 

1. When prompted to select if you want to use the database from the previous version of the 
Altiris Deployment Solution, click Yes to keep all of the data intact. 

 
IMPORTANT:  If you do not keep the existing database, all deployment history, customized jobs, 
and servers listed in the Deployment Server Console are lost. 

 

2. Read the license agreement. If you agree to the terms of the license agreement, click Yes 
to continue. 
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Upgrading 

3. At the Deployment Server Client Access Point Information screen, select Free 7 day 
license or maintenance upgrade to use your current licenses, and then click Next. 
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Upgrading 

4. At the Deployment Server Information screen, complete the console location information 
as appropriate, and then click Next. 

 

3-6 HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 

  
 

HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 10:02 AM 

 



Upgrading 

5. At the Deployment Server Database screen, enter the name of the server where the 
database is located, and then click Next.  

 
 

NOTE:  If the database is located on a remote server, you might be prompted for authentication. Enter 
a user name and password with administrative rights. 

6. If you have an existing SQL database, enter the appropriate SQL user name and password 
in the fields provided, and then click Next to continue. 
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Upgrading 

7. At the PXE Server Information screen, select your PXE options. Be sure that Make this 
server the Master PXE server and Create default PXE boot files are selected, and 
then click Next to continue. 
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Upgrading 

8. At the Client Connection to Deployment Server screen, specify how the client connects to 
the Deployment Server, and then click Next to continue. 

a. Select Use TCP/IP to be sure that the clients connect directly to the Deployment 
Server. 

b. Be sure that the IP address is correct for the Deployment Server. 
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Upgrading 

9. At the Deployment Server Console Information screen, determine the graphical user 
interface (GUI) console location, and then click Next to continue.  

a. If the console will be on the current Deployment Server, select On this computer. 

b. If the console will be on a remote computer, select On a remote computer, and enter 
the name of the remote computer. 
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Upgrading 

10. Click Install at the Installation Information screen. The Deployment Server software 
installation begins. 

11. When prompted to replace the eXpress share, click Yes. 

 

12. Click Finish at the Installation Information Summary screen. 

ProLiant Integration Module for Deployment Server 
 

IMPORTANT:  If you have modified any of the provided batch files, be sure you have made backup 
copies of these altered batch files (located in .\deploy\tools\scripts), because the upgrade program 
overwrites these files with new files. 

1. From the Software Upgrades page, click HP ProLiant Integration Module for 
Deployment Server X.XX, where X.XX is the software version. 

2. Select the deployment jobs to import into the Deployment Server Console, and then 
click Next.  
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Upgrading 

3. Click Next at the Installation screen to begin the software installation. 

New versions of the Rapid Deployment Pack might contain updated versions of the 
ProLiant Support Pack files. The new files are added to .\deploy\cds\compaq\ss.xxx, 
where xxx represents the new support file version. Any jobs added during installation 
reference the new support files. You are prompted to select whether you want to 
overwrite the existing provided jobs. 

4. When prompted, select whether to skip or overwrite existing configuration files, located 
in .\deploy\configs. All files other than the configuration files are overwritten 
automatically, including documentation, the SmartStart Scripting Toolkit, and batch files 
used by the jobs.  
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Upgrading 

5. When prompted, select whether to omit or overwrite any existing jobs in the Deployment 
Server Console with updated jobs. 

If you choose not to overwrite the existing provided jobs, you must manually edit the jobs 
to use the latest ProLiant Support Pack version. For complete instructions to edit the jobs 
to use updated support files, refer to the HP ProLiant Essentials Rapid Deployment 
Pack—Windows Edition User Guide. 

 
IMPORTANT:  If you have modified any of the provided jobs, be sure you have renamed these jobs and 
made backup copies before overwriting the existing jobs. 

 

6. If necessary, you are prompted to insert operating system CDs to allow appropriate files 
required for scripted install jobs to be copied to the Deployment Server directory. Click 
Next to begin the copy process. 

  
IMPORTANT:  If you omit the Windows operating system CD and/or Red Hat Enterprise Linux boot 
file copying steps at this time by clicking Cancel, you can manually install these files at a later time. 
For instructions, refer to the appendices of this guide. 

 
NOTE:  You are prompted for a Red Hat Enterprise Linux CD #1 to copy only the Linux boot files to 
the Deployment Server. The Red Hat Enterprise Linux distribution CDs are still installed on the 
Linux NFS server. The version and Update of the CDs used during the installation of the NFS 
server and the Deployment Server must match. 

HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 3-13 

  
 

HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 10:02 AM 

 



Upgrading 

7. Click Finish when the software installation is complete. 

 

The Deployment Server upgrade is complete. For necessary configuration modifications, 
refer to the appropriate pre-deployment procedures in this guide. 
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Upgrading 

ProLiant Integration Module for NFS Server 
1. Insert the Rapid Deployment Pack—Windows Edition CD into the NFS server. 

2. Log in as root at the NFS server. 

3. Mount the CD using the command: 
mount /mnt/cdrom (Red Hat Linux) 
or 
mount /media/cdrom (UnitedLinux) 

4. Run the setup script:  

/mnt/cdrom/pim-nfs/setup-pimnfs.sh (Red Hat) 

or 

/media/cdrom/pim-nfs/setup-pimnfs.sh (UnitedLinux) 
 

NOTE:  Do not change the directory to the CD-ROM directory to run the setup script. 

5. Enter 1 to start the installation, and press the Enter key. 
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Upgrading 

6. Read the license agreement, and then enter q. 

 

7. If you agree to the terms of the license agreement, enter 1 to accept the license 
agreement, and then press the Enter key. 
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Upgrading 

8. A list of the supported Linux distributions that can be deployed with Rapid Deployment 
Pack appears. Selecting a Linux Distribution copies the ProLiant Support Pack files for 
that distribution and starts the Linux distribution CD query process to copy the Linux 
files onto the NFS server. 

To select a distribution to install, enter the corresponding selection number for the 
distribution, and then press the Enter key. To select all the distributions, enter the 
appropriate number to SELECT all, and then press the Enter key. 

 
NOTE:  Selection numbers will vary depending on the number of available distributions. 

 

9. After selecting all the Linux distribution to be installed, enter the appropriate number to 
ACCEPT selections, and then press the Enter key. The file copy and CD query process 
begins. If the Linux distribution CDs have already been copied to the NFS server, you are 
prompted to select whether you want to copy the files again. 

 
IMPORTANT:  The version and Update of the Red Hat Enterprise Linux CDs used during the 
installation of the NFS server and the Deployment Server must match. 

10. After the ProLiant Support Pack files and distributions files are copied, you are prompted 
for the Rapid Deployment Pack—Windows Edition CD. Insert the CD into the CD-ROM 
drive. 
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11. The following screen appears confirming that the ProLiant Integration Module for NFS 
Server installation is complete. Enter 1 to finish the installation, and then press the Enter 
key. 

 

Before attempting to use the Deployment Server to perform Linux distribution scripted 
installations, complete the appropriate pre-deployment procedures in this guide 



4 
Pre-Deployment Configuration for the 

Deployment Server 

These required and optional configuration modifications are only necessary after a first-time 
installation of the Rapid Deployment Pack. 

Configuring PXE to Automatically Process New Computers 

By default, when a new computer (a computer not listed in the Deployment Server database) 
performs a PXE boot, the PXE server sends the computer the PXE menu and waits for 
manual selection of the Initial Deployment option. This behavior is designed for desktops and 
is not practical for servers, especially server blades with no local keyboard, mouse, or 
display. 

To configure PXE to automatically select the Initial Deployment menu item and continue 
without user interaction: 

1. From the Deployment Server Console menu, select Tools>PXE Configuration. 

2. Select the PXE server from the dropdown list, and then click OK. 
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Pre-Deployment Configuration for the Deployment Server 

3. Click Altiris Bootworks (Initial Deployment)>Edit to display the Menu Item Properties 
screen. 

 

4. Select Execute Immediately. 

5. Click OK to close both windows. 
 

 

CAUTION:  Do not reorder the boot menu located on the Menu Items list on the Boot 
Configuration tab. The Altiris Deployment Solution selects the top menu item as the default 
action when there is no task for a computer to perform. Moving another selection, such as 
Initial Deploy, to the top of the list causes the server to never boot locally, and to cycle in an 
endless loop of reboots. 
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Pre-Deployment Configuration for the Deployment Server 

Synchronizing the Deployment Server Console Name with the 
Windows Name 

The Deployment Server can use a console display name that is different from the actual 
computer name. However, you can select to have the console always reflect the same name as 
the computer name.  

To synchronize the Deployment Server Console and operating system names: 

1. At the Deployment Server Console, select Tools>Options.  

2. At the Program Options window, select the Global tab. 
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Pre-Deployment Configuration for the Deployment Server 

3. Select the Synchronize display names with Windows computer names checkbox. 

4. Click OK. 

5. Click Yes when prompted to restart the control servers. 

 
 

NOTE:  This capability is currently only available for Windows servers running the Altiris Deployment 
Agent for Windows. 

Modifying the Primary Lookup Key 

The Deployment Server uses the primary lookup key to determine if a server is already in the 
database. 

HP recommends setting the primary lookup key as the server serial number. Setting the 
primary lookup key as the server serial number has two benefits: 

• 

• 

It enables servers to be imported by their serial number, rather than keys that are more 
difficult to determine, such as the MAC address. 

It prevents duplicate database entries from occurring when servers have two or more 
NICs. 

4-4 HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 

  
 

HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 9:53 AM 

 



Pre-Deployment Configuration for the Deployment Server 

To change the primary lookup key to the server serial number: 

1. At the Deployment Server Console, select Tools>Options.  

2. At the Program Options window, select the Global tab. 

 

3. From the Primary lookup key dropdown list, scroll up and select Serial 
Number (SMBIOS). 

4. Click OK. 

5. Click Yes when prompted to restart the control servers. 
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Configuring ProLiant BL Server Enclosures 

The Physical Devices view in the Deployment Server Console displays the physical 
relationship among the racks, enclosures, and server blades using the rack name and 
enclosure name for each ProLiant BL server. The default name for the server rack 
is “UnnamedRack,” and the default name for the BL e-Class server enclosure is the MAC 
address of the NIC associated with the Integrated Administrator. 

Setting the rack name and enclosure name is recommended before the first server in an 
enclosure connects to the Deployment Server. After ProLiant BL servers are powered up 
for the first time and the rack and enclosure names are recorded in the Deployment Server 
database, the servers must be rebooted for new rack and enclosure names to be discovered.  
In addition, the default-named rack and enclosure must be manually deleted from the console. 

ProLiant BL e-Class Servers 

To change the rack and enclosure names if the Integrated Administrator port is connected to a 
network with DHCP: 

1. Browse to the DNS name located on the tag attached to the interconnect tray on the 
enclosure. 

2. Log in to the Integrated Administrator using the user name and password located on 
the tag. 
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Pre-Deployment Configuration for the Deployment Server 

3. At the Enclosure Information screen, change the Enclosure Name and Rack Name, and 
then click Apply. 

 
IMPORTANT:  Do not use the same enclosure name for multiple enclosures. Using the same enclosure 
name results in multiple server blades displayed in each bay for an enclosure and duplicate default 
server names. 

 

If the Integrated Administrator port is not connected to a network with DHCP, refer to the 
documentation shipped with the product for details concerning how to access the Integrated 
Administrator using other methods, such as the serial console. 

After configuring the enclosure, install the ProLiant BL e-Class servers into the enclosure by 
following the instructions provided with the server hardware. 

For more information regarding ProLiant BL e-Class servers, refer to the documentation 
shipped with the product. 

ProLiant BL p-Class Servers 

To configure all racks and the ProLiant p-Class enclosure properly, at least one server blade 
must be placed in each enclosure. The server blade should not be powered on until the desired 
rack and enclosure names are set using the Integrated Lights-Out (iLO) interface. Otherwise, 
the server blade will boot to PXE (if enabled), and the default rack and enclosure name will 
be placed in the Deployment Server database. 
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To change the rack and enclosure names if the iLO port is connected to the network with 
DHCP services available: 

1. Browse to the DNS name located on the tag attached to the ProLiant BL p-Class server. 

2. Log on to iLO using the credentials on the tag.  
 

NOTE:  Users that do not have the Administrator ProLiant BL p-Class privilege can only view the 
settings. 

3. Select the BL p-Class tab. 

4. At the Rack Settings screen, change the Rack Name and Enclosure Name. 

 
 

IMPORTANT:  Do not use the same enclosure name for multiple enclosures. Using the same enclosure 
name results in multiple server blades displayed in each bay for an enclosure and duplicate default 
server names. 

5. Click Apply. 

6. After the parameter changes have been made, click Apply to complete the changes. 

7. Log out, and log back on to iLO. 

For more information regarding iLO, refer to the documentation shipped with the product. 

If the iLO port is not connected to a network with DHCP services available, refer to the 
documentation provided with your server blade for details about accessing iLO from the front 
panel of the server blade. 
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 Creating Physical Boot Diskettes for Server Deployment 

If PXE will not be used in the deployment infrastructure, one or more physical boot diskettes 
must be created to enable the target servers to communicate with the Deployment Server.  

To create an MS-DOS boot diskette using the Boot Disk Creator within Altiris: 

1. At the Deployment Server Console, select Tools>Boot Disk Creator.  
The Boot Disk Creator application appears. 
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2. Click the New Configuration icon in the Tasks pane on the left. Enter a name for the 
configuration, such as DOS Boot Disk, and a description in the window that appears, and 
then click Next. 
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3. Select BootWorks boot disk from the available choices, select the Run the Initial 
Deployment for computers not already in the database checkbox, and then click Next. 

 
NOTE:  The Initial Deployment selection can be used on boot diskettes even when the computer is 
a managed computer, and Initial Deployment only runs the first time a computer appears in the 
Deployment Server Console. 
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4. Click Next to accept the default selection of Microsoft Windows. 
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5. Select the appropriate driver for the target server NIC: 

• 

• 

• 

For Intel-based Gigabit NICs, select HP – Intel Gigabit Adapter (n1000 .dos). 

For Intel 10/100 NICs, select HP 10/100TX PCI LAN Adapter.  

For Broadcom-based NICs, select HP NC67xx/NC77xx Gigabit Ethernet. 
 

NOTE:  Be sure the Use Intel universal Network Adapter driver for Preboot eXecution 
Environment (PXE) checkbox is not selected. 

6. Click Next. 
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7. If static IP addresses are required, enter the appropriate information, and then click Next 
to accept the IP settings.  
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8. In the Use TCP/IP to connect to Altiris eXpress server field, verify the Server IP address 
setting reflects the IP address of your Deployment Server, and then click Next. 
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9. Click Next to accept the default workgroup name and login account settings. 
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10. Click Next to accept the default drive mappings settings. 
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11. Click Finish to create the configuration. 

 

12. When prompted to select a media type, select Create floppy disk sets, and click OK. 
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13. Insert a diskette into the diskette drive, select the number of boot disk sets to create, then 
click Next.  
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The Boot Disk Creator begins creating the disks. 
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14. When the diskettes are complete, click Close. 

 

 



5 
Pre-Deployment Configuration for Windows Scripted 

Install Jobs 

These configuration modifications must be performed before using the Windows scripted 
install jobs, and are necessary after a first-time installation or upgrade of the Rapid 
Deployment Pack. 

Preconfiguring the ProLiant Support Pack for Windows 

The Web-based Management portion of the Foundation Agents requires that a password be 
configured in the Smart Component before installation. This password is also used by several 
other components in the ProLiant Support Pack. Without the password, the Web-based 
Management portion of the Foundation Agents installs but does not function correctly and is 
not accessible on your deployed servers. 

 
NOTE:  The components in the ProLiant Support Pack must only be configured one time. The 
components do not have to be configured each time they are deployed. After a component in the 
ProLiant Support Pack is configured, it is ready for deployment. 

To configure the Foundation Agent (and other Smart Components) in the  
ProLiant Support Pack: 

1. Open Windows Explorer and browse to the following directory: 

— For Windows 2000 Server or Advanced Server: 

.\program files\altiris\express\deployment server\deploy\cds\compaq\ss.xxx\w2k\ 
ntcsp 

— For Windows Server 2003, Standard Edition; Windows Server 2003, 
Enterprise Edition; or Windows Server 2003, Web Edition: 

.\program files\altiris\express\deployment server\deploy\cds\compaq\ss.xxx\wnet\csp 

where xxx represents the version of the support files just installed. 

2. Locate and double-click setup.exe. 
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3. If the Remote Deployment Utility displays the following message, click OK to continue.  

 

4. Expand the All Configurable Components directory in the tree in the left pane. 

5. Right-click hp Management Agents for Windows 2000/Server 2003, then 
select Configure. 

 

6. In the Administrator Password section, enter a password in the Password field, and 
confirm. The operator and user passwords can also be entered at this time. 

 
NOTE:  This Administrator password does not have to be the same as the Deployment Server 
Administrator password. 

7. At the Insight Manager 7 Trust Relationship window, select the appropriate trust mode 
for the environment. If security certificates are not currently installed, select Trust All.  

For additional information about selecting a trust mode, refer to the HP Insight 
Management Agents User Guide, located at 
http://h18013.www1.hp.com/products/servers/management/agents.html. 

8. Click Save. 
 

NOTE:  The Version Control Agent for Windows and the Survey utility for Windows can also be 
configured at this time, if desired, in the same manner as the Foundation Agents. 
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Preconfiguring the Altiris Deployment Agent for Windows 

The Altiris Deployment Agent is a service that enables a server to be managed by the 
Deployment Server. It provides the capability to redeploy the server, perform pre- and post-
imaging configurations, and process various commands, such as software installation.  

By preconfiguring the default settings, all agents installed as part of the provided Windows 
scripted install jobs will have the consistent settings. 

The provided Windows scripted install jobs use the aclient.inp file, located in the Deployment 
Server root directory, for agent settings. This setting is independent of the Remote Client 
Installer settings, established from Tools>Options>Agent Settings. 

1. From a text editor, open the aclient.inp file, located in the Deployment Server root 
directory. 

 
NOTE:  By default, the Deployment Server root directory is  
.\program files\altiris\express\deployment server. 

2. Select the option to force applications to close when the server needs to reboot, ensuring 
that jobs will not fail if the server must be rebooted, by changing the following line: 

; ForceReboot=No 

to 

ForceReboot=Yes 

3. Modify the Bootworks disk prompting behavior by changing the following line: 

; BootDiskMessageUsage=4 

to 

BootDiskMessageUsage=0 

If boot diskettes are used instead of PXE, and a configuration task is issued to a computer 
when a diskette is not in the diskette drive, a prompt displays instructing you to insert a 
diskette. If this occurs when you are not logged in to the server, you must log in and close 
the prompt before the job can continue. By selecting to never be prompted for a boot 
diskette, the server reboots to the normal operating system if a boot diskette is not 
inserted in the server when required. 

4. Select the option to synchronize the target server time with the Deployment Server time 
by changing the following line: 

; SynchTimeWithServer=No 

to 

SynchTimeWithServer=Yes 

5. Save the file and close the text editor. 
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Modifying the Microsoft Windows unattend.txt File 

The Windows unattend.txt file controls the Windows unattended installation process. Before 
performing a scripted install, you might need to modify some of the settings to align with 
your environment. Alternatively, you can use the Modify Configuration capability of the 
console to change the settings after installing the operating system. 

 For more information about editing a Windows scripted install unattend.txt file, refer to the 
Windows 2000 online resource kit at 
http://www.microsoft.com./windows2000/techinfo/reskit/en-us/default.asp. 

For the location of the unattend.txt files on the Deployment Server, refer to “Understanding 
the ProLiant Integration Module Deployment Server” in the HP ProLiant Essentials Rapid 
Deployment Pack—Windows Edition User Guide.  

To change the default administrator password: 

1. Locate the [GuiUnattend] section in the unattend.txt file. 

2. Change the AdminPassword= line. 
 

NOTE:  This password is stored and transmitted as cleartext. 

To change the default workgroup or domain name: 

1. Locate the [Identification] section in the unattend.txt file. 

2. To set the workgroup name, change the JoinWorkgroup= line.  

3. To set the domain name, change the JoinDomain= line. 

If you are joining a domain and have not already created a computer account, you might 
need to add CreateComputerAccountInDomain=Yes and set DomainAdmin= and 
DomainAdminPassword=. 

To add the Product ID/Key: 
 

NOTE:  Because the unattend.txt file is used by multiple servers, use a Volume License Key that 
contains multiple or unlimited activations. 

• 

• 

For Windows 2000: 

a. Locate the [UserData] section in the unattend.txt file. 

b. Add ProductID=XXXXX-XXXXX-XXXXX-XXXXX-XXXXX, where the Xs represent 
the key value. 

For Windows 2003: 

a. Locate the [UserData] section in the unattend.txt file. 

b. Add ProductKey=XXXXX-XXXXX-XXXXX-XXXXX-XXXXX, where the Xs represent 
the key value. 

c. You can also add AutoActive=Yes in the [Unattend] section to automatically 
activate the installation. 

http://www.microsoft.com./windows2000/techinfo/reskit/en-us/default.asp


6 
Pre-Deployment Configuration for Linux Scripted Install 

Jobs 

These configuration modifications must be performed before using Linux scripted install 
jobs, and are necessary after a first-time installation or upgrade of the Rapid 
Deployment Pack. 

Preconfiguring the ProLiant Support Pack for Linux 

The Web-based Management portion of the Foundation Agents requires a password to be 
configured before installation. This password is also used by several other components in the 
ProLiant support software. Without the password, the Web-based Management portion of the 
Foundation Agents installs but does not function correctly and is not accessible on your 
deployed servers. 

Support software directories and scripts associated with each Linux operating system 
are located on the NFS server at /usr/cpqrdp/ss.xxx/yyyy/csp, where xxx is the ProLiant 
Support Pack version and yyyy is the Linux distribution shortcut name. For example, rhas21 
represents Red Hat Enterprise Linux AS 2.1.  

A support software script, yyyy.sh, is used to install the ProLiant support software. This script 
uses the input file, linuxpsp.txt, for setting various parameters including the Linux Web 
Agent passwords and SNMP settings. However, for Red Hat 7.2, the Linux Web Agent 
passwords and SNMP settings are located within the support software script, rh72.sh. For 
additional information about the input file and installing the ProLiant Support Pack, refer to 
the ProLiant Support Pack and Deployment Utilities documentation.  

The Linux Web Agent default passwords are listed in Table 6-1 
 

Table 6-1:  Linux Web Agent Default Passwords 

User Name Password 

administrator password 

operator password 

user password 
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Because the default passwords are documented here, HP recommends changing the 
passwords either by editing the support software script as previously described or by 
browsing to the installed server, port 2301 or secured port 2381, and changing the password. 
Changing the password by editing the support software script before a scripted installation 
allows these passwords to be mass deployed to target servers. Additionally, after the scripted 
installation, modified passwords can be replicated by copying the 
/var/spool/compaq/wbem/cpqhmmd.acl file to other servers. 

Preconfiguring the Deployment Settings for Red Hat Linux 
Scripted Install Jobs 

For the Red Hat Linux scripted install jobs to operate properly, they must be modified with 
the host and domain name or IP address of the NFS server on which the installation files 
are located.  

To update each Red Hat Linux scripted install job to point to the NFS server: 

1. Locate the Red Hat Linux scripted install jobs to be modified within the Deployment 
Server Console. Expand the tree view, if necessary, to view the jobs in the Jobs pane. 

2. Double-click the job. The Job Properties screen appears. 

 

3. Double-click the Run Script— Install OS task.  

4. Locate the following line in the script: 

set nfsserver=0.0.0.0 

6-2 HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 

  
 

HP CONFIDENTIAL Codename: Quicksilver Part Number: 352869-002 Last Saved On: 1/9/04 9:55 AM 

 



Pre-Deployment Configuration for Linux Scripted Install Jobs 

5. Change 0.0.0.0 to the host and domain name of the NFS server as follows: 

set nfsserver=yournfssvr.yourdomain 

where yournfssvr is the host name of the NFS server, and yourdomain is the domain 
name for the NFS server. 

Instead of a host name and domain name, an IP address can be specified as follows: 

set nfsserver=xxx.xxx.xxx.xxx 

where xxx.xxx.xxx.xxx is the fixed IP address of the NFS server. 
 

NOTE:  Using the IP address to connect to the NFS server is more effective than using a DNS 
name, because using a DNS name requires the existence of a DNS server properly configured with 
an entry for the NFS server. 

6. Click Finish to save changes. 

7. Repeat steps 2 through 6 for any remaining Red Hat Linux scripted install jobs. 

Preconfiguring the Deployment Settings for UnitedLinux 
Scripted Install Jobs 

For the UnitedLinux scripted install jobs to operate properly, they must be modified with the 
host and domain name or IP address of the NFS server where the installation files are located.  

To update each UnitedLinux scripted install job to point to the NFS server: 

1. Locate the UnitedLinux scripted install jobs to be modified within the Deployment Server 
Console. Expand the tree view, if necessary, to view the jobs in the Jobs pane. 

2. Double-click the job. The Job Properties screen appears. 
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3. Double-click the Run Script— Install OS task. 

4. Locate the following line in the script: 

set nfsserver=0.0.0.0 

5. Change 0.0.0.0 to the host and domain name of the NFS server as follows: 

set nfsserver=yournfssvr.yourdomain 

where yournfssvr is the host name of the NFS server, and yourdomain is the 
domain name of the NFS server. 

Instead of a host name and domain name, an IP address can be specified as follows: 

set nfsserver=xxx.xxx.xxx.xxx 

where xxx.xxx.xxx.xxx is the fixed IP address of the NFS server. 
 

NOTE:  Using the IP address to connect to the NFS server is more effective than using a DNS 
name, because using a DNS name requires the existence of a DNS server properly configured with 
an entry for the NFS server. 

6. Click Finish to save changes. 

7. Repeat steps 2 through 6 for any remaining UnitedLinux scripted install jobs. 



7 
Pre-Deployment Configuration for Packaged Cluster 

Deployment Jobs 

These configuration modifications must be performed before using the provided packaged 
cluster deployment jobs for Windows, and are necessary after a first-time installation or 
upgrade of the Rapid Deployment Pack. 

Step 1:  Creating and Customizing a Configuration File 
1. On the Deployment Server, copy and rename the clustername.ini file in 

the .\deploy\configs\clusters directory.  
 

IMPORTANT:  A unique cluster configuration file must be created for each packaged cluster to be 
deployed. This file must have the same name as the packaged cluster being deployed. 

2. In the new file, specify a domain administrator-level account name and password for the 
cluster. This account will be used to run the cluster service. 

3. Specify an IP address and subnet mask for the cluster. 

4. Specify the domain for the cluster. 

5. Specify the available private IP addresses for the private NIC in each node in the cluster. 

6. Specify the Windows network name for the private NIC in each node participating in the 
cluster. 

7. Specify the Windows network name for the public NIC in each node participating in 
the cluster. 
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For example, refer to the following sample cluster configuration file text. 

 
 

NOTE:  If standard packaged cluster hardware is used, the default network names provided in the 
cluster configuration file will work, as long as they are not changed from the default Windows install 
during the scripted installation or in the server image. 

 
IMPORTANT:  Microsoft Cluster Services requires a domain administrator account to run the cluster 
service. This password is stored in plain text in the cluster configuration file on the Deployment Server. 
HP recommends protecting server administrator passwords by ensuring that: 

• Only authorized users have access to the eXpress share where the configuration files are located. 

• A user account exists for accessing the eXpress share separately from the rest of the 
Deployment Server.  

Step 2:  Providing the Domain Administrator Account for 
Packaged Cluster Deployment 

Each packaged cluster deployment job for Windows contains a task to create or join the 
cluster from each node. Windows security requires that this task be run by an account with 
domain administrator credentials. Provide these credentials for each packaged cluster 
deployment job to be run in a particular domain:  

1. Open the Job Properties window for the packaged cluster deployment job. 

2. Scroll to the Create/Join Cluster task and click Modify>Advanced. 

3. In the Security Context area, select Enter user name and password, and supply the 
domain/user name and password valid in the domain for the cluster.  

4. Click OK to close the window, and then click Finish to close the Script Properties 
window. 

5. Click OK to close the Job Properties window. 

6. Repeat steps 1 through 5 for each packaged cluster job before deployment. 
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Step 3:  Making the Cluster Nodes Available in the Deployment 
Server Console 

The cluster nodes must be available in the Deployment Server Console and organized in a 
group named for the packaged cluster they will form before running the packaged cluster 
deployment jobs.  

Importing the Cluster Node 

Import the cluster nodes into the Deployment Server Console using one of the following 
methods. 

Method One— New Computer GUI 

Using the New Computer GUI provided by the Deployment Server Console: 

1. Open the New Computer Properties dialog box. 

2. Click File>New>Computer. 

3. Click Add. 

4. Enter the Name, Serial Number, and Computer Name. 

5. Click Microsoft Network. 

6. Select Domain, and enter the domain the node will join. 

7. Click TCP/IP. 

8. Click Add next to the Network Adapter dropdown menu. Network Adapter 2 appears in 
the list. 

9. Select Assign a static IP address. 

10. Enter an IP address and subnet mask for the private network card in this node. 

11. Click OK to close New Computers Properties. 

12. Repeat steps 3 through 11 to provide the information for the second node. 

13. Click OK to close New Computers. 
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Method Two— Import Computers From a File  

Use the Import Computers from a File method in the Deployment Server Console to create an 
import file based on the sample import file, clusimport.csv in .\deploy\configs\clusters.  

In the following sample file, the cluster node is named “clusnode1,” the serial number is 
“D207KGY1K056,” a “1” indicates domain membership joining the RDP domain, a “1” 
indicates DHCP for NIC 1, the cluster name is “mycluster,” the IP address and subnet 
mask is “15.15.15.1,” and “255.0.0.0” indicates its private NIC. 

clusnode1,,D207KGY1K056,,clusnode1,1,RDP,,1,,,,,,,,,,,,,,,,, 
HASE,HP,,,,,,,,,,,,,,,mycluster,,,,0,15.15.15.1,255.0.0.0 
clusnode2,,D207KGY1K057,,clusnode2,1,RDP,,1,,,,,,,,,,,,,,,,, 
HASE,HP,,,,,,,,,,,,,,,mycluster,,,,0,15.15.15.2,255.0.0.0 

Method Three— Modify After Initial Deployment  

Modify the computer name in the console after initial deployment (the first PXE boot) of 
the cluster nodes, add the nodes to a computer group in the console, and name this group 
after the cluster to be formed. 

 
IMPORTANT:  Method three is only available if using the scripted packaged cluster deployment jobs. 

Creating the Computer Group  

After the computers are in the console, create a new computer group with the same name as 
the cluster to be formed.  

1. Right-click in the Computers pane, and select New Group.  

2. Rename this group to the name of the cluster. 

3. Drag the nodes to form this cluster into the new group. 

The cluster nodes should now be listed in a group with the same name as the cluster 
they will form. The following figure displays a cluster group called “mycluster” and the 
nodes “clusnode1” and “clusnode2.” 
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Pre-Deployment Configuration for Packaged Cluster Deployment Jobs 

Step 4:  Customizing the Microsoft Answer Files for Packaged 
Cluster Scripted Install Jobs 

1. Specify a domain-level administrator account and password in the unattended Windows 
install answer files. For Windows 2000, this file is w2kclus.txt, and for Windows Server 
2003, this file is wnetclus.txt. These files are located in the Deployment Server in the 
.\deploy\configs\clusters directory.  

2. Update the file with the following information: 

— A domain administrator account name 

— The password for that account 

— The domain for that account (which the cluster nodes will join) 

For example: 

[Identification] 

DomainAdmin=* 
DomainAdminPassword=* 
JoinDomain=* 

 
NOTE:  This account does not need to be the domain administrator account for the cluster, but the 
account must have permission to add computers to the domain. 
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Pre-Deployment Configuration for Packaged Cluster Deployment Jobs 

Step 5:  Creating a Reference Configuration for a Packaged 
Cluster Imaged Install 

If using the Packaged Cluster Imaged Install for Windows job, a reference ProLiant DL380 
server configuration is needed. This reference server must be configured with the Microsoft 
Windows 2000 Advanced Server or Microsoft Windows Server 2003, Enterprise Edition. 
Additionally, any minimum required service packs and support packs must be installed. An 
image of this server is then taken for use in the Packaged Cluster Imaged Install for Windows 
job. Perform the following steps to correctly configure the reference server: 

1. Install the desired operating system on the reference server. 

a. For Windows 2000, select the Cluster Service component during setup to copy the 
clustering binaries to the server before imaging. 

b. For Windows Server 2003, the necessary clustering software is automatically 
installed, so this additional setup task is not required. 

 

2. Install any service packs and support packs to the reference server. 

3. Capture an image of the reference server with the Capture Hardware Configuration and 
Windows Image job located in the SmartStart Toolkit and OS Imaging Events folder. 
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Pre-Deployment Configuration for Packaged Cluster Deployment Jobs 
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4. After the Capture Hardware Configuration and Windows Image job has completed on the 
reference server, browse to the image file on the Deployment Server. This file is located 
in the .\images folder. Rename the file wincap.img to a filename describing the operating 
system and the server type captured.  

 
NOTE:  HP recommends making a copy of the Capture Hardware Configuration and Windows 
Image job. Rename the job and edit it to create an image with the desired file name.  

5. From the Deployment Server Console, make a copy of the Packaged Cluster Imaged 
Install for Windows job and rename it based on the type of server and operating system 
captured. In this new job, open the Deploy Image task and edit the image file name to 
point to the reference server image file.  

 
 

IMPORTANT:  The image specified for a Packaged Cluster Imaged Install for Windows job that will 
deploy a Windows 2000 image must contain the clustering binaries. If deploying a Windows 2003 
server image, this is not a requirement because the cluster binaries are a default component of this 
version of Windows. 

 

 



A 
Manually Installing Windows Operating System CDs 

If you did not copy the Windows operating system CDs during the installation, manually 
copy the files for each omitted operating system to ensure that the provided Windows jobs 
operate properly. 

To manually copy the Windows operating system files to the Deployment Server directory: 

1. Locate the .\deploy\cds\windows directory on the Deployment Server. If this directory 
does not exist, create it. 

2. Select the appropriate directory for the operating system files to be copied. If this 
directory does not exist, create it. 
 

Table A-1:  Windows Operating System Shortcut Names 

Operating System  Shortcut Name 

Windows 2000 w2k 

Windows Server 2003 wnet 

3. Copy the i386 directory from the operating system CD to the operating system directory. 
 

NOTE:  The provided Windows scripted install jobs rely on the existence of operating system files 
at .\deploy\cds\windows\xxx\i386, where xxx is the operating system shortcut name. 
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B 
Manually Installing Red Hat Enterprise Linux Boot Files 

If you did not copy the Red Hat Enterprise Linux boot files during the installation, manually 
copy the files for each omitted distribution to ensure that the provided Red Hat Enterprise 
Linux jobs operate properly. 
 
NOTE:  Linux boot files for all other Linux distributions are provided on the Rapid Deployment 
Pack— Windows Edition CD and installed during the ProLiant Integration Module for 
Deployment Server installation. 

To manually copy the Red Hat Enterprise Linux boot files to the Deployment Server 
directory: 

1. Locate the .\deploy\cds\compaq\ss.xxx\yyyy directory on the Deployment Server, where 
xxx is the ProLiant Support Pack version and yyyy is the Linux distribution shortcut name 
for the distribution files to be copied. 

 

Table B-1:  Linux Distribution Shortcut Names 

Linux Distribution Distribution Shortcut Name 

Red Hat Enterprise Linux AS 2.1 rhas21 

Red Hat Enterprise Linux ES 2.1 rhes21 

Red Hat Enterprise Linux AS 3 rhas3 

Red Hat Enterprise Linux ES 3 rhes3 

 
IMPORTANT:  The copied boot files must match the distribution version copied during the ProLiant 
Integration Module for NFS Server installation or the manual installation of Linux distribution CDs. 

2. Insert the first distribution CD into the Deployment Server CD-ROM drive. 
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3. Copy the following files into the Deployment Server directory from Red Hat 
Linux CD #1 as shown in Table B-2. 

 

Table B-2:  File Sources and Destinations 

Source Destination 

/dosutils/loadlin.exe .\deploy\cds\compaq\ss.xxx\yyyy\dosutils\loadlin.exe 

/images/pxeboot/vmlinuz .\deploy\cds\compaq\ss.xxx\yyyy\dosutils\autoboot\vmlinuz 

For rhas21 and rhes21: 
/images/pxeboot/ 
initrd-everything.img* 

For rhas3 and rhes3: 
/images/pxeboot/initrd.img 

.\deploy\cds\compaq\ss.xxx\yyyy\dosutils\autoboot\initrd.img 

*  Rename the copied initrd-everything.img file to initrd.img. 

  

 



C 
Manually Installing Linux Distribution CDs 

If you did not copy the Linux distribution CDs during the installation, manually copy the files 
for each omitted distribution to ensure that the provided Linux jobs operate properly. 

To manually copy a set of Linux distribution CDs to the NFS server directory: 

1. Locate the /usr/cpqrdp/yyyy directory on the NFS server, where yyyy is the Linux 
distribution shortcut name for the omitted distribution. 

 

Table C-1:  Linux Distribution Shortcut Names 

Linux Distribution Distribution Shortcut Name 

Red Hat Enterprise Linux AS 2.1 rhas21 

Red Hat Enterprise Linux ES 2.1 rhes21 

Red Hat Enterprise Linux AS 3 rhas3 

Red Hat Enterprise Linux ES 3 rhes3 

Red Hat 7.2 rh72 

Red Hat 7.3 rh73 

Red Hat 8.0 Professional rh80 

 
IMPORTANT:  The copied Red Hat Enterprise Linux distribution files must match the boot files version 
copied during the ProLiant Integration Module for Deployment Server installation or during the manual 
installation of the Red Hat Enterprise Linux boot files. 

2. Insert the first distribution CD into the NFS server CD-ROM drive. 

3. Mount the CD-ROM drive: 

mount /mnt/cdrom (Red Hat) 

or 

mount /media/cdrom (UnitedLinux) 

4. Copy the contents of the distribution CD, including subdirectories, to the distribution 
directory. For example: 

cp –r  /mnt/cdrom/* /usr/cpqrdp/rhas21 
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5. Unmount the CD-ROM drive: 

umount /mnt/cdrom (Red Hat) 

or 

umount /media/cdrom (UnitedLinux) 

6. Repeat steps 3 through 5 to copy the remaining CDs in the distribution set to the 
distribution directory. The distribution CDs containing the RedHat/RPMS directory are 
required. However, all distribution CDs in the set might not be needed. 
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